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BR&E ProMax® 3.0 (Build 3.0.12198.0) Release Notes 
16 July 2012 

Bryan Research & Engineering, Inc. 
 

Welcome to the release of ProMax 3.0 (build 3.0.12198.0).  This upgrade is a maintenance 
upgrade to earlier ProMax 3.0 builds.  If you need assistance or would like to report a problem in 
ProMax, please contact our technical support group at support@bre.com.  You may also consult 
our frequently asked questions list at http://www.bre.com/promax-faq.aspx.  In addition to 
common usage questions, this list contains solutions to common problems related to program 
installation.  Finally, we would encourage you to seek our assistance in questions related to 
program applicability.  ProMax is a robust, accurate simulator that can be used in many 
processes 
 
These release notes describe the major changes that have occurred between the ProMax 3.0 
release and the ProMax 2.0 release.  Refer to the release notes from previous versions of ProMax 
to determine the significant changes made within a specific release and the changes made 
relative to the predecessors of ProMax, PROSIM® and TSWEET®.  These can also be requested 
by email from our support group at support@bre.com. 
  
ProMax utilizes Microsoft Visio® 2002, Microsoft Visio 2003, or Microsoft Visio 2007 as its 
drawing package.  All flowsheets are drawn using Visio.  You must have a legal copy of either 
Microsoft Visio 2002, 2003, or 2007 Professional or Standard to use ProMax through its GUI.  
This particular version of ProMax is not compatible with other releases of Visio, including 
any future releases.  The version of Visio installed on your computer can be found by using the 
Help->About menu item in Visio.  Microsoft offers a trial version of Visio on its website at 
http://office.microsoft.com/visio.  Additionally, depending on the version, Visio requires a patch 
from Microsoft to use successfully with ProMax.  See Obtaining the Required Visio Patch 
section below for more details. 
 
The following table lists the operating system compatibility with ProMax 3.0.  Special attention 
should be paid to the notes concerning your respective operating system.  Upgrading the 
operating system is strongly recommended for any system that is not in the mainstream support 
phase of Microsoft as BR&E does not perform routine testing of ProMax on these platforms and 
full compatibility is suspect.  For all systems, a minimum of 512 MB of RAM is required, with 
more usually required depending on operating system, application load, and other software 
needs. 
 
Operating System Edition Notes 
Windows 2000 Professional or 

Server 
Not supported.  Microsoft ended the extended 
support phase for Windows 2000 on 13 July 
2010. 

Windows XP All x86 SP3 required 
Windows XP Professional x64 SP2 required 
Windows Server 2003 x86 or x64 SP2/R2 required 
Windows Vista All x86 and x64 RTM/SP1/SP2 

Microsoft support for RTM ended 10 April 2010.
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Windows Server 2008 All x86 and x64 SP1/SP2 
Windows Server 2008 R2 x86 unavailable RTM/SP1—Full support requires ProMax 3.1 or 

later. 
Windows 7 All x86 and x64 RTM/SP1—Full support requires ProMax 3.1 or 

later. 
 
  
When ProMax is loaded by Visio, Visio will issue a warning concerning the presence of macros.  
This warning is provided by Microsoft Office applications to warn you of the possible presence 
of viruses that may be present within the macros.  Microsoft has created a strategy where the 
macros are digitally signed by their author so you are assured of their integrity.  Digital 
signatures require a trusted third party to verify the authenticity of the signature and its data.  Not 
all macros are signed.  The author of unsigned macros is unknown and usually should be 
considered suspect.  All BR&E documents pertaining to Visio or other Microsoft Office 
applications are digitally signed.  This digital signature can be verified by inspecting the 
certificate displayed in the warning message.  You must allow all BR&E signed macros to 
execute or you will prevent ProMax from functioning properly.  You should add BR&E to your 
trusted list of macros to ensure proper execution of ProMax.  
 
Obtaining the Required Visio Patch or Service Pack in Visio 2002 & 2003 
 
During ProMax development in mid 2003, BR&E discovered a problem in Microsoft Visio that 
can cause corruption in files saved in ProMax or Visio due to loss of digital certificate 
signatures.  While this problem was discovered during the initial beta test period for Visio 2003, 
we were unable to determine the exact cause of the problem with Microsoft at that time and 
consequently a solution was not obtainable.  Early in 2004, we discovered the fundamental cause 
of the problem and were able to work with Microsoft to develop a Visio patch to solve this issue. 
 
The digital certificate problem is present in both Visio 2002 and Visio 2003.  Unfortunately, it 
may be more severe in Visio 2002 because the problem is present without warning to the user.  
With the release of Microsoft Office 2003 products, Microsoft set the default macro security 
level in documents to high.  This causes any document with a missing digital certificate to fail on 
load.  However, in Visio 2002, the default macro security level is medium which does not cause 
failure on load.  Files saved with Visio 2002 will likely fail if the user upgrades to Visio 2003 if 
the digital signature has been silently lost unless the security level is changed. 
 
You can determine if the minimum patch level is met by inspecting the full build available from 
the Help->About menu item in Visio.  For Visio 2003, the build number must be 11.4301.6360 
or greater.  For Visio 2002, the build number must be 10.0.6002 or greater. 
 
For Visio 2003 users, the patch has been rolled into Service Pack 2 (and Service Pack 3) for 
Visio 2003 which may be downloaded from the Microsoft Office website at 
http://office.microsoft.com/en-us/officeupdate/default.aspx.  However, for Visio 2002 users, the 
method to obtain the fix is through a Visio patch or hotfix.  As of this writing the patch has not 
been rolled into a Visio 2002 Service Pack.  Due to copyright restrictions, the patch must be 
obtained directly from Microsoft.  You can obtain the patch for Visio 2002 (10.0.6002) by 
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following the instructions in the Microsoft Knowledge Base article 890668 available at 
http://support.microsoft.com/?id=890668.  Note that you must apply Visio 2002 Service Pack 2 
before installing this patch.  Due to the severity of this problem and the potential for data loss, 
ProMax will issue a warning each time you start the application if this patch is not installed.  
There should be no cost involved with obtaining the patch.  Please contact our customer support 
if you have questions or problems with the above requirement. 
 
Warnings and Warranty   
 
The user assumes full responsibility for the results and application obtained from the use of 
ProMax.  No implied warranty of merchantability, no implied warranty of fitness for any 
purpose, and no implied warranty arising by usage of trade, course of dealing, or course of 
performance is given by BR&E or shall arise from ProMax. 
 
THE FOREGOING WARRANTY IS IN LIEU OF ALL OTHER WARRANTIES EXPRESSED 
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. 
 
ProMax is protected by copyright law and international treaties.  Unauthorized reproduction, 
distribution, reverse engineering, or use of this program, or any portion of it, may result in severe 
civil and criminal penalties and will be prosecuted to the maximum extent possible under law. 
 
ProMax, PROSIM, and TSWEET are registered trademarks of Bryan Research & Engineering, 
Inc. 
 
Installation of ProMax 3.0 
 
ProMax uses Windows Installer Service 3.1 (WIS) technology for installation.  The installer 
supports standard as well as administrative installs through a file or application server.  In this 
release, a security device is not required to perform the installation.  However, you must have a 
valid BR&E security device present to run ProMax.  To install ProMax on a workstation, you 
must either be an administrator, or you must have elevated installation privileges set through 
either an IntelliMirror® approach or a group policy setting.  Although not absolutely required, 
BR&E recommends that Microsoft Visio be installed and functioning prior to installing ProMax. 
 
During the installation process, ProMax 3.0 will uninstall prior versions of ProMax 2.0 or 
ProMax 1.x that may be installed.  Simultaneous installation of multiple versions of ProMax is 
not allowed.  User customizations made to the Options.xml file will be migrated into the ProMax 
3.0 files. 
 
You should insure your system meets the minimum software requirements before installing.  
ProMax will not run properly on systems that do not meet the minimum software 
requirements.   Please see the table given earlier that provides the minimum software 
requirements.  BR&E recommends that you keep your system up to date with current service 
packs and major patches to ensure compatibility now and in the future. 
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When performing the install, you should select to install the SafeNet Sentinel LDK Run-Time 
Environment (RTE).  In previous versions, the security device driver was required only if a key 
was physically attached to the system running ProMax.  Currently, the RTE is required to 
provide communication with the license manager in network environments as well.  SafeNet 
recommends that the RTE installation be performed without the security device attached to the 
system. 
  
If you are using a network based security device, the Sentinel LDK RTE must be installed on the 
system that will host the key and serve as the network License Manager (LM).  You may select 
any system in your network for this service that is accessible by the workstations that will run 
ProMax with a static IP address or hostname resolvable by DNS.  The RTE software is available 
with the DVD distribution in a folder named “Sentinel Key”.  Both GUI and command line 
versions of the installer are present.  There is also a BR&E vendor specific version of the 
command line installer that is required if the license manager will host software keys for 
detachable licenses.  This version will install BR&E vendor specific libraries that are required 
for use with software keys.  Please see the document “ProMax Security Key Information” on the 
ProMax DVD or the ProMax help for more information on this topic. 
 
Unless the Sentinel License Manager is available through IP broadcast, the RTE will require 
configuration to specify the address or DNS name of the system with the network key.  This 
configuration must be made on each system that will run ProMax.  This configuration is made 
through a web based console that configures the RTE.  The web application is called the Sentinel 
Admin Control Center (ACC).   The configuration is performed using http protocol on port 1947.  
To access the configuration section, open your web browser and navigate to the location 
http://localhost:1947.  Click Configuration under Options followed by the Access to Remote 
License Managers tab.  On that page, use the Specify Search Parameters to enter either the IP 
address or the hostname of the system with the network key.  Multiple locations may be 
specified by placing entries on separate lines.  This will be required if separate systems are used 
to host Sentinel protected applications from different vendors, or if you host ProMax keys on 
more than one license manager.  Separate host systems are not required with different 
applications as any number of keys can be attached to a single host.  However, you may 
distribute Sentinel keys to separate hosts as you desire.  By default, only local administration of 
the Sentinel LDK RTE is permitted.  This can be changed on the Basic Settings tab.  For more 
information concerning the Sentinel Admin Control Center, select the help links on the 
appropriate page. 
 
Performing the Initial Installation of ProMax 3.0 from DVD 
This procedure is intended for use on systems that do not contain an earlier version of ProMax 
3.0, but may contain a version of ProMax 2.x or earlier.  If an earlier version of ProMax is 
installed, you should normally leave it installed so that the settings can be migrated into the 
current release during installation. 
 
To install the program on these systems, insert the DVD into your system.  The system should 
auto-run the DVD and allow you to start the installation program.  If needed, you may start the 
installation program by running the SETUP.EXE program on the DVD.  You should invoke the 
SETUP.EXE program rather than the MSI file as this program ensures all prerequisite 
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components are installed.  The installation program will determine the type of installation that 
needs to be made (fresh install or upgrade) and perform the appropriate action. 
 
To perform an administrative install, you must run SETUP.EXE with the /a command line 
option.  Note that an administrative install is used for placing ProMax on a file server for 
distribution using IntelliMirror or other alternative approaches.  The administrative install does 
not actually install the application on the server.  Do not confuse an administrative install with 
the administrator account or elevated privilege requirement for installing on a single workstation.   
 
ProMax requires several prerequisite software packages to be installed before the actual ProMax 
installation can be attempted.  If you install ProMax using the SETUP.EXE program on the 
DVD, these prerequisite packages will automatically be installed if missing.  However, if you 
install ProMax on workstations in your network using the administrative installation approach or 
use another alternative installation approach, you must ensure these prerequisites are properly 
installed before attempting the ProMax installation.  Specifically, Microsoft SQL Server Express 
2005 SP4 must be installed prior to installing ProMax.  SQL Server Express 2005 further 
requires the Microsoft .Net Framework 2.0 SP2 be installed.  In addition, the Microsoft .Net 
Framework 4 Client Profile is required for the new Licensing Wizard and Notification Manager.  
For your convenience, these prerequisites are located on the DVD distribution.  They are also 
available from the Microsoft download site, http://www.microsoft.com/downloads.  SQL Server 
Express requires special configuration for the ProMax installation to succeed.  In particular, a 
dedicated instance of SQL Express is required.  Please see the content of the Prerequisite.xml file 
for the command line required to install SQL Express.  SQL Server Express cannot be installed 
on systems with less than 512 MB RAM.  When ProMax is removed from the system, the 
dedicated SQL Server Express instance may also be removed. 
 
If desired, Microsoft SQL Server Express 2008 or 2008 R2 may be used instead of Microsoft 
SQL Server Express 2005.  Please contact BR&E for instructions on installing Microsoft SQL 
Server Express 2008 or 2008 R2. 
 
Depending on the operating system language and version, you may receive an error stating “The 
Windows Installer service cannot update the system file C:\WINDOWS\system32\msxml6r.dll 
because the file is protected by Windows. You may need to update your operating system for this 
program to work correctly.” during the installation of SQL Server Express 2005.  This error has 
been documented by Microsoft in Knowledge Base article 958897 (see 
http://support.microsoft.com/kb/958897).  You may click the OK button to ignore this error as 
long as no other errors occur during the installation of SQL Server Express.  ProMax is 
distributed with all available languages of SQL Server Express, and this error should not appear 
unless an English version must be installed on a non-English operating system due to the fact 
that Microsoft does not supply a version of SQL Server Express for your particular language. 
 
Updating Earlier ProMax 3.0 Releases using a Windows Installer Patch 
The simplest method to upgrade ProMax is through the FlexNet Connect service in ProMax.  
Using this approach, all of the details of downloading and applying the patch are automatically 
handled.  Simply log into an account with elevated installation privileges, and use the FlexNet 
Connect Program Manager on the start menu in Windows (labeled Software Updates), or the 
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“Help->ProMax Help->Check for Updates” menu item in ProMax itself to obtain and apply the 
patch.  You may also use the FlexNet Connect Program Manager to download and save the 
patch, and subsequently apply it using the instructions below if it is to be applied to multiple 
systems.  Note that the FlexNet Connect service is being replaced by the BR&E Notification 
Manager in this release (see below for more information).  Consequently, once the update is 
installed, the FlexNet Connect service will no longer be available for use by ProMax. 
  
If desired or if you do not use the FlexNet Connect service, you may download and apply the 
patch manually.  Please contact BR&E if you need the link for the download.  The upgrade is 
distributed as a single compressed Microsoft IExpress executable file containing the patch file 
(MSP) for the Windows Installer Service.  When warranted, BR&E provides two versions of the 
patch for download.  The binary difference patch is a smaller download, but usually requires 
access to the original ProMax DVD to apply on Windows XP, but will install on Windows Vista 
and later without the media.  The full-file patch is a larger download, and does not require the 
original ProMax DVD source.  If you extract the MSP patch file from the download executable 
file, do not attempt to apply the patch by simply double clicking the MSP file in Windows 
Explorer.  You must manually run the Windows Installer program (msiexec) supplying the 
appropriate command line switches for proper patching to occur.  In general, we recommend you 
apply the patch using the downloaded executable file directly without extracting the MSP file as 
the proper command line switches are automatically inserted for you.  Improper command line 
switch usage will result in incorrect patching and application failure. 
  
For standalone installations, simply follow these instructions to install the patch (the original 
DVD distribution may be needed for the binary difference patch as discussed above): 
  
1) Log in using an account with elevated privileges. 
2) Download the patch using the FlexNet Connect Program Manager or the link supplied by 

BR&E.  If required, supply any required information on the website. 
3) You may either download and save the patch from the website or run the self-extracting 

patch file directly without download.  If you download the patch, you must run the self-
extracting patch file after the download to start the patch process. 

  
To patch a Windows Installer administrative installation used to distribute the application in a 
network environment, the steps are: 
  
1) Download the patch using the FlexNet Connect Program Manager or the link supplied by 

BR&E.  If required, supply any required information on the website. 
2) Extract the MSP patch file to a temporary folder from the downloaded patch package. 
3) Log in using an account with sufficient privileges to modify the administrative share and to 

force redeployment of the application. 
4) Patch the administrative share using the command: 

 
msiexec /a [Path to Administrative Image]\ProMax.msi /p [Path to MSP Binary Patch] 
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5) Force a redeployment of the ProMax application using Active Directory or other approach 
used to redeploy the application. 

Upgrading Earlier ProMax 3.0 Releases using the DVD Distribution 
The upgrade of earlier ProMax 3.0 releases may be accomplished using a ProMax DVD as an 
alternative to the Windows Installer patch.  Since the patch process is typically much faster to 
perform, the DVD will normally be distributed to customers upon request.  To upgrade a 
standalone installation, simply run the Setup.exe program on the DVD using an account with 
elevated installation privileges.  Do not uninstall the earlier release before performing the 
upgrade. 
 
If you wish to use the MSI file directly, you must issue the case-sensitive command: 
  

msiexec /i [path to DVD]\ProMax.msi REINSTALL=ALL REINSTALLMODE=vomus 
  
You cannot simply double click the MSI file in Windows Explorer because the command line 
options above will not be present.  Improper use of command line arguments will result in 
improper application installation and failure of ProMax to execute properly.  The Setup.exe 
program internally determines the current installation state and starts the msiexec process using 
the proper command line arguments. 
 
Known Issue Upgrading from the ProMax 3.0.9065 Release 
If you receive an error that contains a message with the text InstallerComponentCodeUpdate 
included, please contact BR&E for a workaround.  This issue should rarely be encountered. 
 
New Features in ProMax 3.0.12198 Relative to ProMax 3.0.9065 
 

1. The security model from the upcoming major release of ProMax, ProMax 4.0, has been 
incorporated into this build.  The new security model offers many enhancements, including 
detachable licenses for network licensees.  The design also offers improved reliability and 
availability in networks, especially in environments with high simultaneous demand such 
as classrooms.  This update is required to provide compatibility with the security device as 
used in ProMax 4.0.  Without this upgrade, you will not be able to use the same security 
device with ProMax 4.0 and earlier releases of ProMax.  To provide compatibility with all 
earlier releases, updates are being made available to versions of ProMax back to version 
1.2.  A PDF document entitled “ProMax Security Key Information” is being made 
available as part of the DVD distribution to assist you in installing and activating the 
security device.  Initial use of keys requires activation with the new Licensing Wizard 
which is distributed with this update.  Please see the document for more information. 

2. The FlexNet Connect system by Flexera Software is being replaced by a BR&E internally 
developed utility called the BR&E Notification Manager in order to serve the requirements 
of ProMax better. 
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New Features in ProMax 3.0.9065 Relative to ProMax 2.0 
 

1. The electrolytic models have been extended to characterize more completely the short 
range ionic interactions that occur in solution.  These modifications include the amine-acid 
gas system and the ammonia-acid gas systems.  The changes improve the model 
predictions for the acid gas vapor-liquid equilibria, and enable better predictions for more 
concentrated solutions and higher acid gas loadings.  For the MDEA-CO2-H2O system in 
particular, this has resulted in more optimistic predictions relative to ProMax 2.0 version. 

2. The electrolytic models include the dissociation for the following molecular components:  
Sulfur Dioxide, Phenol, Calcium Hydroxide, and Piperazine. 

3. Several improvements have been made with regard to glycol dehydration and glycol 
injection processes. 

a. In ProMax 2.0, changes were made based on customer comments that caused the 
performance of TEG units to be more conservative with respect to water content 
relative to ProMax 1.2. After release of ProMax 2.0, BR&E decided to scrutinize 
this problem fully and decided that there were simply insufficient reliable data in 
critical areas of this process.  In some regions, the only data present are graphs 
that disagree from vendor to vendor, and frequently from publication to 
publication from the same vendor.  Most importantly, these graphs do not provide 
an indication of how much measured data are used to create them and if true 
measurements are present in the critical regions.  The nature of these data leads to 
significant design uncertainties, especially for high dew point depression systems.  
Consequently, BR&E commissioned a study with a reputable research firm with 
significant experience collecting this type of data to acquire VLE data in these 
questionable areas.  Further, the group was asked to collect data in regions that we 
felt were known with some confidence to insure the quality of the measurements.  
The results of this experimental study have been incorporated into ProMax 3.0.  
Therefore, the user will find that ProMax 3.0 will not be as conservative as 
previous releases of our software and the user should not assume conservative 
results are generated using ProMax 3.0. 

b. Improvements in prediction of solubilities of minor components in glycol systems 
have been made.  These include hydrocarbons and various sulfur species.  While 
only small amounts of data are present for many of these minor components, the 
results from ProMax 3.0 should be more reliable than earlier versions. 

4. For most systems, ProMax 3.0 should require less calculation time than its earlier versions. 
5. RVP units have been changed to gauge from absolute pressure.  This will require all 

calculators that use RVP to be adjusted for the new units.  Other uses in the program are 
automatically fixed when the file is read. 

6. Projects can now be exported for appending in other projects.  A project is exported in its 
entirety into a file with a pmxexp extension.  This file can then be appended to other 
projects using the File menu.  Objects with conflicting names are automatically renamed 
during the append process.  Among other uses, this procedure can be used to create 
templates of common processes (e.g., dehydration, amine sweetening, refrigeration, etc.) 
for appending in other projects.  Since the process of exporting and appending transfers the 
project in its entirety, the project upon which the export is based should normally be as 
simple as possible to prevent deleting unused objects after the append.  Please note that you 
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should keep both the standard project file (pmx) along with the export file (pmxexp).  The 
export file is specific to the version of Visio used to create it and will need to be recreated 
from the pmx file when a Visio upgrade is made. 

7. Improvements in predictions for DEPG (Coastal AGR) systems have been made.  Among 
the many improvements include better prediction of high hydrogen systems such as those 
involved in synthesis gas treating.  Improvements in hydrocarbon solubility predictions 
have also been made. 

8. The ability to model gas treating (including synthesis gas) using the physical solvent 
propylene carbonate has been added.  The recommended property package for this system 
is either Peng-Robinson or SRK. 

9. Extractive processes for olefins and acetylenes utilizing N,N-Dimethylformamide (DMF) 
can now be modeled.  The appropriate property packages include either the Gibbs excess 
models (e.g., NRTL) or Peng-Robinson Polar or SRK Polar. 

10. Pertinent information from GPA Standard 2145-09 has been added to ProMax due to its 
recent adoption. 

11. The correlations in Figure 22-10 of the 12th edition GPSA Engineering Databook for COS 
and CS2 hydrolysis have been added.  These correlations can be added to any Claus bed to 
model the hydrolysis of COS and CS2 into H2S and CO2.  The correlations are for activated 
alumina catalysts.  Other catalysts will yield different performance.  In addition, a new 
Gibbs set named “GPSA Hydrolyzing Claus Bed” has been created that will automatically 
add these correlations to a Gibbs minimization reactor.  The previous “Hydrolyzing Claus 
Bed” has been renamed to “Equilibrium Hydrolyzing Claus Bed” to indicate that the 
hydrolysis is modeled at equilibrium.  While normally predicting a conversion less than 
equilibrium conversion, the GPSA hydrolysis correlations can predict a conversion that 
exceeds equilibrium conversion at certain conditions.  This fact is a general statement for 
any conversion correlation.  When this occurs, a warning is provided in the reactor.  One 
remedy for this warning is to deactivate the constraint of the offending component (usually 
COS) so that it is modeled at equilibrium.  The component must remain active in the 
reactant list or it will be considered an inert.  Alternatively, a linear constraint may be 
constructed to limit the conversion. 

12. The following changes have been made to the heat exchanger rating program: 
a. Double pipe heat exchangers can now rate Inline (straight path) as well as Hairpin 

(U-tube) type exchangers. 
b. Heat transfer film coefficients have been improved, especially for boiling and 

condensation conditions.  Calculation of condensation film coefficients has been 
made less aggressive when non-condensables are present. 

c. Several issues affecting calculations of tube count and total area have been 
resolved. 

d. Several issues in heat exchanger pressure drop calculations have been resolved. 
e. Impingement calculations and recommendations for shell and tube exchangers 

have been improved. 
f. The ProMax double pipe shell side interface has been simplified to remove 

unnecessary properties. 
g. Several new properties have been added and are described in the ProMax Help. 

Specific properties at each side increment are grouped on a Detail tab apart from 
the more general properties. 
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13. The cross exchanger properties Minimum End Approach Temperature, Log Mean 
Temperature Difference and End Point UA can now be set by the user. A direct solution 
will only be obtainable for those cases in which at least two of the connected streams can 
be solved independently before the cross exchanger is called upon to solve for the 
remaining streams.  Other cases will require a recycle with initial guess for calculation. 

14. Tooltips that display values in common units are shown when the mouse is placed over a 
value.  These tooltips can be disabled by the user if desired.  Further, the units which are 
displayed for a value can be configured by modification of the Options.xml file. 

15. Reporting flexibility has been greatly increased with the user capability to define templates 
for Microsoft® Excel reporting.  These templates are standard Excel workbooks that are 
edited with a report editor supplied in the Excel Add-In “ProMax User Defined Report.xla” 
located in “%ProgramFiles%\Bryan Research & Engineering\ProMax3\AddOns\Excel” 
folder.  The editor gives the ability to place ProMax data in locations while leaving other 
aspects of formatting and layout to the familiar tools built into Excel.  Report templates can 
be applied to any ProMax project via ProMax’s Report dialog.  For further information or 
assistance with template creation, please contact our technical support group at 
support@bre.com. 

16. A custom property package is no longer required to obtain liquid densities from the 
equation of state.  When applicable, the density selection in the environment will allow the 
EOS density to be selected in addition to either COSTALD or Rackett.  EOS densities 
normally provide better estimates for the liquid in the critical region.  The application of 
EOS densities will most commonly be encountered in CO2 acid gas injection systems. 

17. The Span and Wagner equation of state for pure CO2 was implemented based on Span, R., 
Wagner, W., J. Phys. Chem. Ref. Data, Vol. 25, No. 6, 1996, pp. 1509-1596.  This equation 
of state represents most experimental data within experimental uncertainties. It produces 
exceptional accuracy in the critical region. In addition, in technically important regions up 
to pressures of 30MPa and up to temperatures of 523K, the estimated uncertainty of the 
formulation ranges from ±0.03% to ±0.05% in density and ±0.15% to ±1.5% in the isobaric 
heat capacity. This empirical formulation is valid in the fluid region up to temperatures of 
1100K and at pressures up to 800 MPa.  This model can be used to model acid gas 
injection systems without water present to determine if the properties computed by other 
EOS's such as Peng-Robinson or SRK are accurate enough for use.  Since this equation of 
state is a pure fluid equation of state, no hydrate predictions can be made with this package. 

18. The IAPWS (International Association for the Properties of Water and Steam) Formulation 
2001 for Thermodynamic Properties of Ammonia-Water mixtures presented in Guideline 
on the IAPWS Formulation 2001 for the Thermodynamic Properties of Ammonia-Water 
Mixtures, The International Association for the Properties of Water and Steam, 
Gaithersburg, Maryland, 2001, has been added as the Tillner-Roth and Friend NH3 + H2O 
Property Package.  This correlation provides the most accurate description of 
thermodynamic properties of ammonia-water mixtures available at the time it was 
developed over a wide range of conditions.  It is valid in the vapor and liquid phases for 
pressures up to 40 MPa.  The formulation represents the vapor-liquid equilibrium 
properties with an uncertainty of ±0.01 in liquid and vapor mole fractions.  In the single 
phase region, uncertainties are estimated from ±0.3% to ±1% in vapor density and from 
±0.3% to ±2% in liquid density, and ±200 J/mol for enthalpies.  This model can be used to 
represent ammonia-water mixtures as the working fluid in absorption refrigeration cycles 
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or other systems where binary ammonia-water mixtures are encountered.  Additionally, the 
equation of state for pure ammonia presented by Tillner-Roth, R., Harms-Watzenberg, F., 
Baehr, H.D., Eine neue Fundamentalgleichung für Ammoniak, Proc. 20th DKV-Tagung 
Heidelberg, Germany, Vol. II, 1993,  pp. 167-181, has been added.  The ammonia 
correlation provides a good description of the thermodynamic properties of ammonia over 
a wide range of measurements available at the time this correlation was formulated.  
Finally, the IAPWS Formulation 1995 for Thermodynamic Properties of Water 
implemented by Wagner, W., Pruss, A., J. Phys. Chem. Ref. Data, Vol. 31, No. 2, 2002, 
was added.  This formulation covers a range of temperatures from the melting line (lowest 
temperature 251.2K at 209.9 MPa) to 1273K and pressures up to 1000 MPa.  In the liquid 
region, the estimated uncertainty ranges from ±0.001% to ±0.02% in density and ±0.1% in 
the isobaric heat capacity.  In the gas region, the estimated uncertainty ranges from ±0.03% 
to ±0.05% and ±0.2% in the isobaric heat capacity.  In the critical region, the IAPWS-95 
formulation represents with a very good accuracy both thermal and caloric properties. 

19. The individual diatomic deuterium (D2) modifications are now present in ProMax.  The 
program includes orthodeuterium, paradeuterium, equilibrium deuterium, and normal 
deuterium.  The previous versions of the program only included normal deuterium.  Normal 
deuterium is a constant composition mixture of 75% paradeuterium and 25% 
orthodeuterium.  ProMax will accurately predict the equilibrium distribution of para and 
ortho deuterium in a Gibbs free energy minimization reactor.  If the generic names for 
diatomic deuterium (i.e., D2, Deuterium) are selected as components, the program will use 
normal deuterium as in the past. 

20. Materials of Construction for pressure vessels and exchanger rating have been updated to 
the 2007 ASME Boiler and Pressure Vessel Code, including the 2008a Addenda. 

21. Thermoplastic piping is now available as a Material of Construction in the Pipeline block 
and Line Sizing analysis. 

22. In the Line Sizing analysis, two additional pressure design codes are available for 
calculating the Maximum Allowable Working Pressure: 

 Canadian Standards Association CSA Z662 Oil and Gas Pipeline Systems  
 ASME B31.4 Pipeline Transportation Systems for Liquid Hydrocarbons and 

Other Liquids. 
23. The materials in CSA Z245.1 "Steel Pipe" are available as Materials of Construction for 

Line Sizing and Pipelines. 
24. In the Line Sizing analysis, the B31.3 pressure code has been updated to include the Weld 

Joint Strength Reduction Factor, which was added to the design equation by errata in 
ASME B31.3-2006.  The coefficient Y has also been added.  Both of these parameters are 
calculated by ProMax or can be optionally specified by the user. 

25. Standard Dimension Ratio (SDR) pipe sizes and all pipe sizes from ASME B36.10M are 
now available in the Line Sizing analysis and the Pipeline.  Pipe sizes can be specified in 
either Nominal Pipe Size (NPS) or Diameter Nominal (DN), which is the dimensionless 
designator used in the metric system to describe pipe size.  The NPS, DN, and thickness 
can be selected from dropdown lists of the sizes available for the specified Pipe Schedule. 

26. Absolute Roughness values for common pipe materials can be selected from dropdown 
lists in Pipelines and Line Sizing analyses. 
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27. Pipeline enhancements include: 
 The Initial Value Method, either EPISODE or Runge-Kutta, can now be selected 

when the Continuous Solution Method is specified.  EPISODE is the default, but 
Runge-Kutta may solve faster in some cases. 

 An option to Check Freezeout per Increment has been added.  By default, it is 
unchecked, and Freeze Out will be checked only at the beginning and end of the 
pipeline and between segments or fittings.  If this property is check-marked, then 
Freeze Out will be checked at every increment to determine exactly where freeze 
out begins or is within range of freezing. 

 For pipelines with multiple pipe segments, if only one Ambient Temperature is 
specified, all other segments will default to this Ambient Temperature.  For wells 
with specified elevation changes in the segments, if at least two Ambient 
Temperatures are specified, the other Ambient Temperatures will be calculated 
based on the elevation gradient of the specified temperatures. 

 Pressure drop through valves and fittings can now be calculated using the 
Equivalent Length ratio, L/D, which may be more accurate than the Fitting Kv 
calculation for compressible flow, especially near sonic velocity. 

28. Distillation Column Hardware properties can now be specified directly in the Hardware 
dialogs.  The Edit dialogs have been removed. 

29. ProMax can now be used to size liquid-liquid columns by using the liquid load (total liquid 
flux) on a stage.  Specify either the diameter or the liquid load (which is sum of both liquid 
flows on stage) and the other parameter is calculated. For amine liquid-liquid columns, 
recommended liquid loads are 15 gpm/ft2 (610 lpm/m2) for gas plants and 10 gpm/ft2 
(405 lpm/m2) for refinery service. 

30. Distillation columns now allow Murphree Efficiencies greater than 100%, which can be 
useful to fine tune predictions to operating data for amine and other columns. 

31. The dialogs for the Recycle/Propagation Terminal have been redesigned for ease of use. 
32. The advanced solver and specifier provide additional flexibility in the calculation source.  

Previously only Excel and VBScript or JScript were allowed.  In the current version, the 
option of using Visual Basic for Applications (VBA) in Visio or Excel and the use of an 
external COM object written in any COM compliant programming language are available.  
ProMax can directly call the COM object, or you can connect your implementation to 
ProMax using COM connection points (events).  The connection point method is also 
available in VBA.  These new capabilities make it easier to create solvers and specifiers 
based on programs that may already be internally available. 

33. The combustion analysis will now calculate heating values on a molar, mass, and 
volumetric basis.  In addition, the combustion and metering temperatures may be specified 
at the combustion analysis level to serve as the basis for computation.  For more 
information, see GPA Standard 2172 and ISO 6976. 

34. ProMax Property Stencil has been expanded with several new calculation shapes, a simple 
membrane and orifice plate block.  Two selection shapes were also included to assist users 
in creating their own block shapes, and to add default values and calculators to block 
shapes. 

35. The Bottoms Head specification has been added to the staged column properties to account 
for the liquid head between the bottom of the column and the reboiler. 

36. Sizing a three phase separator no longer requires a vapor flow. 
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37. Petro-Therm™ and Shell Thermia® C heat transfer fluids have been added. 
38. The units TR for ton of refrigeration and RT for refrigeration ton have been added. 
39. Adjustments and bug fixes have been made to curve oils. If the user wishes to incorporate 

these changes into existing flowsheets the oil must be recharacterized manually by the user. 
This can be done by modifying something in the characterization.  

 The easiest way to recharacterize the boiling point data is by changing the Assay 
Type and then resetting to the original Assay Type.  

 The easiest way to recharacterize user supplied curve data for specific gravity and 
molecular weight is to edit the data, alter the amount for the highest or lowest 
fraction distilled, click OK, and then reedit the data restoring the original value. 

 The easiest way to recharacterize user supplied curve data for high and low 
temperature viscosity is to delete the Viscosity Assay temperature and hit enter to 
restore the temperature.  

40. Most examples have been updated and several new examples have been added to 
demonstrate new or improved features of the program. 

 An MDEA Sweetening with Piperazine example has been added to the Amine 
Sweetening folder. 

 A pair of examples has been added to the Calculators folder to demonstrate new 
calculator Source Types, a VBA type and an Event Based type (using VBA). 

 The Gas Processing folder contains new JT examples, a GSP unit, and a 
propylene carbonate unit for synthesis gas treatment.   

 The Refining folder contains many new examples: Benzene Removal from Fuel 
Stock, Butadiene Extraction using DMF, Hydrogen Production and Purification, a 
new Coker Fractionation column with side strippers, an FCC Fractionation 
column, and an FCC SO2 Offgas Scrubber. 

 Most Sulfur Recovery examples have been converted to employ the GPSA 
Hydrolyzing Claus Bed Gibbs Set. 

 A new Power and Refrigeration folder demonstrates the setup of ammonia 
absorption refrigeration, Kalina and Rankine cycles, and refrigerant systems.   

The examples have been solved in ProMax 3.0 and each example is ready for inspection 
41. Several bug fixes have been made. 
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